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In This Guide
Agilent GC ChemStation Familiarization
This guide contains a step-by-step exercise to help you become 
familiar with your Agilent G2070BA GC ChemStation software 
used with the Agilent 7890A GC. Revisions covered by this 
manual includes B.04.03.

To successfully complete this exercise, you need the following:

• Agilent G2070BA GC ChemStation software

• Agilent 7890A GC with:

Before operating your instrument, be sure to read all safety and 
regulatory information included with the instrument.

GC Inlet: Split/Splitless Inlet with EPC  
(default inlet configuration)

Column: HP-5 30 m × 320 µm × 0.25 µm

Sample: P/N 5188- 5372

Detector:

ALS

FID

Agilent 7693 or 7683 automatic liquid 
sampler (Optional)
1
 Startup the System

This chapter includes a startup checklist for instrument 
readiness.
2
 Create a Method for Qualitative Analysis

This chapter describes how to the method is created by 
uploading the GC method parameters from the GC and saving. It 
also describes how to create an acquisition method that will be 
used to identify the compounds in an Agilent standard sample. 
3
 Run a Single Sample

This chapter describes how a sample is prepared for data 
acquisition. The ALS is loaded with the sample, the solvent 
wash vial, and a solvent waste vial. Finally, the sample is run 
and the logbook, showing the actions taken during the run, is 
reviewed.
4
 Qualitative Data Analysis

This chapter explains how to set up data analysis options, 
modify integration results, perform manual interactive 
integration of peaks, print area percent reports, and edit the 
data analysis part of the method.
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4

Create and Run a Sequence

This chapter describes how to create a sequence and acquire 
data for the calibration samples which are used in the next 
chapter to update the calibration curve.
6
 Create a Calibration Method

This chapter describes how to setup a calibration table with 
compounds and calibrators to identify unknown samples. This 
new calibration table is then used with a reprocessing sequence 
to report on the quantity of compounds found in these samples.
7
 Easy Sequence

This chapter describes how to use a template based sequence 
creation system to create a recalibration sequence that fits into 
a daily workflow requiring re-calibrations before processing 
samples.
8
 Create a Maintenance Method

This chapter describes how to create and store a method to use 
for instrument shutdown and maintenance tasks. Using this 
type of method helps prevent damage to the instrument 
electronics and columns, and avoid injuries such as burns or 
shocks.
Agilent GC ChemStation Familiarization Guide



Where to Find Information

Hardware
Agilent GC ChemStation Familiarization
In addition to this document, Agilent provides several learning 
products that document how to install, operate, maintain, and 
troubleshoot Agilent instruments. This information can be found on 
the Agilent Technologies GC and GC/MS Hardware User Information 
and Utilities DVDs that ship with your instrument.
Included on these DVDs is an extensive collection of localized online 
help, videos, and books for current Agilent gas chromatographs, mass 
selective detectors, ion traps, and GC samplers including:

• Getting Familiar documentation

• Safety and Regulatory guides

• Site Preparation checklists

• Installation information

• Operating guides

• Maintenance information

• Troubleshooting details
Software
For more information on the G2070BA GC ChemStation in 
addition to this book, refer to the on-line help.
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Agilent G2070BA GC ChemStation
Familiarization Guide
1
Startup the System

Start up the System    12

Bakeout the Flow Path    13

Method and Run Control View User Interface    15

In this chapter, a startup checklist is reviewed for instrument 
readiness. The GC’s analysis flow path is baked out. The Agilent 
ChemStation is started and a brief description of the user 
interface is given. 
11Agilent Technologies



1 Startup the System
Start up the System 
12
This procedure starts with the GC turned off and all hardware 
previously configured. Items requiring a possible change in 
configuration to suit a particular method are addressed here. 
These include the column, gas types used in pneumatic 
controllers, inlet liners and O-ring, and septums.

1 Review the Agilent 7890A Gas Chromatograph Safety 
manual (P/N G3430-90013) and Agilent 7890A Gas 
Chromatograph Operating manual (P/N G3430-90010) for 
important safety information and start up details before 
powering on your instrument.

2 Gather the following:

• Evaluation column, HP- 5 30 m x 0.32 mm x 0.25 µm 
(19091J- 413)

• FID performance evaluation (checkout) sample 
(PN 5188- 5372)

• Chromatographic- grade iso-octane 

• 4- mL solvent and waste bottles or equivalent for 
autoinjector

• 2- mL sample vials or equivalent for sample

3 Verify the following:

• Capillary column jet installed. If not, select and install a 
capillary column jet.

• Capillary column adapter installed (adaptable FID only). 
If not, install it.

• Chromatographic- grade gases plumbed and configured: 
helium as carrier gas, nitrogen, hydrogen, and air.

• Empty waste vials loaded in sample turret.

• 4-mL solvent vial with diffusion cap filled with iso-octane 
and inserted in Solvent A injector position.

4 Verify that the split/splitless (S/SL) inlet septum, liner, and 
O-ring are clean, properly installed, and in good condition. 
See the procedure in the 7890A Maintenance manual 
(G3430-90010).

5 Install a conditioned (HP-5 30 m x 320 µm x 0.25 µm) 
column in the GC. Attach the column inlet to the S/SL inlet 
and its outlet to the FID. See the procedure in the 7890A 
Maintenance manual (G3430-90010).

6 Verify that the He carrier gas line valve is open and the 
carrier gas is attached to the GC inlet flow module.
Agilent GC ChemStation Familiarization Guide



Startup the System 1

Agilent GC ChemStation Familiarization
7 Verify that the H2, makeup gas, and air gas line valves are 
open and these lines are attached to the GC FID module.

8 Verify that the GC is connected to a grounded power source.

9 Power on the 7890A GC. 

10 To specify the column configuration, from the GC keypad 
press [Config][Col 1] (or [Config][Col 2]).

The column dimensions are located on a metal tag located 
on the column basket.

a Scroll to the Length line, type the column length, in 
meters, followed by [Enter].

b Scroll to Diameter, type the column inside diameter in 
microns, followed by [Enter].

c Scroll to Film thickness, type the film thickness in microns, 
followed by [Enter]. The column is now defined.

d Scroll to Inlet. Press [Mode/Type] to select a gas pressure 
control device for this end of the column. Select the front 
or back inlet location with the split/splitless inlet and 
press [Enter].

e Scroll to Outlet. Press [Mode/Type] to select a gas pressure 
control device for this end of the column. Select the front 
or back detector location with the FID and press [Enter].

f Scroll to Thermal zone. Press [Mode/Type] to see the 
available choices. Select the GC Oven and press [Enter].

11 To specify carrier gas flow to the column, from the GC 
keypad, press [Col 1] (or [Col 2]).

a Scroll to Mode. Press [Mode/Type], select Constant Flow and 
press [Enter].

b Scroll to Velocity and enter 30 to set the column velocity to 
30 cm/s. The Pressure and Flow values are calculated and 
displayed by the GC.
Bakeout the Flow Path
1 Purge the column with carrier flow for at least 20 minutes 
before heating the column. The HP-5 column in our example 
has a maximum temperature of 325 °C. Do not exceed the 
maximum temperature noted on your column.

2 To set up the inlet temperature and flow:

a From the GC keypad, press [Front Inlet] (or [Back Inlet] if 
the Split/Splitless is located there) and with Temperature 
selected press [On/Yes] and enter 300 °C or 25 °C above 
 Guide 13
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1 Startup the System
the normal operating temperature, to turn on the inlet 
heater and set its temperature. 

b Press [Up Arrow] to select Mode and press [Mode/Type] to 
select Split mode and press [Enter].

c Press [Down Arrow] to select Pressure and press [On/Yes] 
to open the carrier gas control valve.

d Press [Down Arrow] twice to select Split flow, enter 
200 mL/min and press [Enter]. Split ratio will be calculated 
for you.

3 To set the column temperature from the GC keypad, press 
[Oven] and with Temperature selected press [On/Yes] and 
enter 225 °C, or 25 °C above the GC method final oven 
temperature. This turns on the oven heater and set its 
temperature. Do not exceed the column manufacturer’s 
maximum temperature limit.

4 To set up the FID:

a From the GC keypad, press [Front Det] (or [Back Det] if the 
FID is located there) and with Temperature selected press 
[On/Yes] and enter 325 for the detector Temperature to turn 
on the detector heater and set its temperature to 325 °C. 

b Press [Down Arrow] to select H2 Flow and press [On/Yes] 
and enter 30 mL/min.

c Press [Down Arrow] to select Air Flow and press [On/Yes] 
and enter 400 mL/min.

d Press [Down Arrow] to select Makeup and press [On/Yes] 
and enter 25 mL/min.

e Press [Down Arrow] to select Flame and press [On/Yes] to 
ignite the flame.

f To check the FID baseline output, press [Down Arrow] to 
view the Output. It should be between 5 pA and 20 pA and 
relatively stable. (If using a gas generator or ultra pure 
gas, the signal may stabilize below 5 pA.) If the output is 
outside this range or unstable, resolve this problem 
before continuing.

g If the output is too low:

•Check that the electrometer is on.

•Check that the flame is lit.

5 Bakeout the flow path for a minimum of 30 minutes. 
Agilent GC ChemStation Familiarization Guide



Startup the System 1
Method and Run Control View User Interface
Agilent GC ChemStation Familiarization
1 Power on the PC and log into Windows.

2 From the Windows start icon, click All Programs, click Agilent 
ChemStation, then click the on-line ChemStation program for 
your instrument.

The ChemStation user interface is displayed. Click the 
Method and Run Control button located in the left pane at the 
bottom, to display the ChemStation Method and Run Control 
view, if that view is not displayed.
Figure 1 Method and Run Control view user interface

ChemStation Explorer for methods and sequence templates

Navigation buttons to other views
The ChemStation Explorer allows for easy access to specific files 
(e.g. methods and sequences in Method and Run Control view) and 
fast access to other ChemStation views.
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1 Startup the System
The ChemStation user interface is displayed as views that group 
software functionality according to typical analytical tasks. The 
following three standard views are present in all software 
configurations:

• the Method and Run Control view for controlling and acquiring 
data from the instrument

• the Data Analysis view for reviewing and reevaluating data 
that has been acquired

• the Report Layout view for designing specific report layouts

The Data Analysis view extends the standard toolbar to specific 
data analysis modes including integration, calibration, 
reporting, annotation, and signal comparison. These separate 
data analysis modes are supported with a mode-specific toolset.

The Report Layout view allows you to graphically define the 
layout of a specific report style. It also uses a set of toolbars 
specific to this task.

The ChemStation Explorer is used to navigate through sequences, 
methods, and data files. Use the Navigation Buttons to switch the 
ChemStation Views.
Agilent GC ChemStation Familiarization Guide



Startup the System 1
Configure Method and Run Control Views
Agilent GC ChemStation Familiarization
The Instrument Control tab in the Method and Run Control view 
displays several view components that assist in monitoring the 
instrument. You select these components from the View menu. 
Figure 2 shows where to select these view components listed on 
the menu as Online Signals, Instrument Actuals, Sampling Diagram, 
GC Instrument Diagram, ChemStation Status, and Logbook.

The view selectors shown in Figure 2 allow you to store 3 
different groupings of these view components. First click on a 
view selector icon to display the group of UI components on the 
Instrument Control tab selected for that icon. Next you can select 
additional (unchecked) view components from the View menu or 
select an existing view component (checked) to remove it from 
the Instrument Control tab. Likewise you can configure the other 
two view selector icon to display different component 
groupings.

Figure 2 Select view components to display in a custom view

View components

View selectors
 Guide 17
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1 Startup the System
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Agilent G2070BA GC ChemStation
Familiarization Guide
2
Create a Method for Qualitative 
Analysis

Introduction    20

Edit the Entire Method    21

General Information for Editing the GC Parameters    35

Assigning Signals with Dual Simultaneous Injections    44

This chapter describes how to create an acquisition method that 
will be used to identify all compounds in an Agilent standard 
sample.
19Agilent Technologies



2 Create a Method for Qualitative Analysis
Introduction
20
The acquisition method presented in this chapter will be used 
to find the known compounds in the Agilent sample PN 5188- 
5372. The sample compounds are contained in a iso-octane 
solvent as shown in Table 1. Three 0.5 mL ampules are included.

The data acquisition parameters used in this method are taken 
from the FID performance section in the Chromatographic 
Checkout chapter of the Agilent 7890A Gas Chromatograph 
Advanced User Guide (G3430-90015). If your inlet and detector 
are different than the Split/Splitless - FID setup used in our 
example, find your detector and inlet in the Chromatographic 
Checkout chapter of this manual and use the parameters found 
there for good separation of these sample compounds.

Table 1 Sample compound list

Compound Concentration in iso-octane

n-Tridecane 2.36 mg/L

n-Tetradecane 2.36 mg/L

n-Penta-decane 23.6 mg/L

n-Hexadecane 23.6 mg/L
Agilent GC ChemStation Familiarization Guide



Create a Method for Qualitative Analysis 2
Edit the Entire Method
Agilent GC ChemStation Familiarization
With on-line session connected to the 7890A, upload the current 
method from the GC and Save with a new Method Name such as 
default.m or first connect.m.

1 Click the Method menu then click Edit Entire Method…, to 
create the method. The Edit Method dialog box opens.

2 Mark the Method Information and Instrument/Acquisition 
checkboxes only. Clear the Data Analysis and Run Time 
Checklist checkbox.

The Data Analysis part of the method will be updated after 
the run.
 Guide 21
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2 Create a Method for Qualitative Analysis
3 Select OK to close the Edit Method dialog box. If Method 
Information was selected, the Method Information dialog box 
opens.

4 In the Method Comments field, enter a description of this 
method.

5 Select OK to close the Method Information dialog box and 
display the Select Injection Source/Location dialog box.

6 From the Select Injection Source dropdown list, select your 
source. Only configured injector sources are listed.

• If you are injecting from the GC using the Automatic 
Liquid Sampler (ALS), select GC Injector.

• If you are manually injecting select Manual.

• If using a valve select GC valve. The GC used for this 
example does not have valves installed.

7 In the Select Injection Location area, select an injection 
location of Front, Back, or Dual.

8 Select OK to close the Select Injection Source/Location dialog 
box and display the Setup Method window.
Check the GC configuration
1 Select the Configuration button,  to specify pressure 
units, configure a column, and specify gas types for pressure 
and flow controllers associated with detectors, inlets, and 
auxiliary devices. 

2 With the Miscellaneous tab selected, select the Pressure Units 
type. Under Valve Configuration set up valves if installed or set 
all Valve Types to Not Installed. Review the online help for an 
explanation of Slow fan and Thermal Aux Type.
Agilent GC ChemStation Familiarization Guide



Create a Method for Qualitative Analysis 2
Figure 3 Miscellaneous configuration tab 
Agilent GC ChemStation Familiarization
Table 2 lists a description of the Setup Method window buttons.

Table 2 Setup method window buttons

Button Action

Apply Downloads any settings that have been changed to the GC.

OK Downloads any settings that have been changed to the GC 

and closes the Setup Method window.

Upload from 
Instrument

If setpoints are changed via the keyboard, they can be 

uploaded to the ChemStation.

Cancel Discards any settings that have been changed and closes the 

Setup Method window.

Help Displays help topics for the current parameter.
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24

2 Create a Method for Qualitative Analysis
3 Select the Columns tab to display the column configuration 
parameters. The HP-5 checkout column is listed in the 
Column position 1. 
Figure 4 Columns configuration tab
4 If the HP-5 is not listed under Column, or another column 
will be used, click the Inventory button and add it to 
inventory before listing it here. See “Add a column to 
ChemStation local inventory”  on page 36.

5 Use the up and down arrow keys to move the HP-5 column 
into one of the six column positions. The column is generally 
installed in the 1 position.

6 For the Inlet pressure for this column, select the location of 
the Split/Splitless inlet from the dropdown.

7 For the column Outlet pressure select the FID location.

8 For the column Heated By select Oven from the dropdown.

9 Click the Apply button and select the Modules tab.
Agilent GC ChemStation Familiarization Guide



Create a Method for Qualitative Analysis 2
Figure 5 Modules configuration tab
Agilent GC ChemStation Familiarization
10 Select He or H2 as the carrier gas from the dropdown for the 
inlet connected to column 1.

11 Select He or N2 as the Makeup gas from the dropdown for the 
Front Detector.

12 Click the Apply button and select the ALS tab.
Figure 6 ALS configuration tab
13 Enter a Syringe Size of 10 µL.
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2 Create a Method for Qualitative Analysis
14 Select a Solvent Wash Mode of A, B.

The other Solvent Wash Mode options, A-A2, B-B2 and A-A3, 
B-B3, are used with sequences.

15 Click the Apply button to download any edits to the GC.
Set the GC readiness state
The 7890 GC readiness state is reached when all GC parameters 
specified here are within their method specified setpoints. This 
Readiness requirement can also be set from the 7890A GC 
keypad.

1 Select the Readiness button, . The Readiness 
parameters are displayed.
Figure 7 Readiness state component selection
2 Select the Oven, Front Inlet and Front Detector (both attached to 
column 1). These selections require the GC to wait until all 
setpoints related to the oven, inlet, and detector are held at 
a steady value before allowing a run to begin.

3 Click Apply to download these selections to the GC.
Agilent GC ChemStation Familiarization Guide



Create a Method for Qualitative Analysis 2
Set the GC oven parameters
Agilent GC ChemStation Familiarization
1 Select the Oven button, . The Oven parameters are 
displayed.

For this example, the FID Checkout Oven program is used.
Figure 8 GC oven parameters
2 Mark the Oven Temp On checkbox.

3 In the Equilibration Time field, enter 0.5 min to shorten the 
default time of 3 min.

4 In the Maximum Oven Temperature field, enter 325 °C. This is 
the maximum temperature for the HP-5 column.

5 Clear the Override Column Max. 325 °C checkbox.
 Guide 27
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2 Create a Method for Qualitative Analysis
6 In the Oven Ramp table, enter the settings shown in Table 3.

7 In the Post Run field, enter 220 °C.

8 In the Post Run Time field, enter 2 min to hold the 220 °C 
oven temperature for 2 minutes after the run is finished. 

9 Select Apply to download these settings to the GC.

Table 3 Oven ramp settings 

Oven Ramp Rate Value Hold Time

°C/min °C min

(Initial) 75 0.5

Ramp 1 20 190 0
Set the GC column parameters
1 Select the Columns button,  . The Column parameters 
are displayed

2 Check the Column information in the Selection list.

• Column: 19091J-413 (HP-5 30 m x 320 µm x 0.25 µm)

• In: front or back (split/splitless inlet position)

• Out: FID

3 Mark the Control Mode checkbox.

4 Select Flow in the Control Mode area.

5 In the Flow Setpoint field, enter 6.5 mL/min. The Pressure, 
Average Velocity, and Holdup Time Setpoints are calculated and 
displayed in the corresponding fields.

6 Select Apply to download these settings to the GC.
Agilent GC ChemStation Familiarization Guide
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Agilent GC ChemStation Familiarization
Set the GC inlet parameters

Figure 9 GC columns parameters
1 Select the Inlets button, . The Inlet parameters are 
displayed.
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2 Create a Method for Qualitative Analysis
Figure 10 GC inlet parameters
30
2 Select the front or back tab, depending on your hardware 
configuration.

3 Mark the Heater checkbox and enter 250 °C in the 
corresponding Setpoint field.

4 Mark the Pressure checkbox. The psi in the corresponding 
Setpoint field is automatically set when the column flow rate 
is set.

5 Mark the Septum Purge Flow checkbox and enter 3 mL/min in 
the corresponding Setpoint field.

6 From the Septum Purge Flow Mode drop down list, select 
Standard.

Gas Saver reduces the carrier gas flow rate from the split 
vent after a sample is within the column. The program 
maintains column head pressure and flow rate while purge 
and split vent flow rates are decreased. See online help for 
details.
Agilent GC ChemStation Familiarization Guide
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Agilent GC ChemStation Familiarization
In general, start Gas Saver after inlet purge time for splitless 
injection or 2 minutes after a split injection. Reduced flow 
rates continue until the next run. To use Gas Saver, select it 
and enter:

• The reduced split vent flow rate you want (in mL/min)

• The time, in minutes, when flow rate is to decrease after 
a run has started

Keep Gas Saver 15 mL/min above the maximum column flow 
rate during the run.

7 In the Mode area select Splitless.

8 In the Purge Flow to Split vent area:

a In the field, enter 40 mL/min.

b In the at field, enter 0.5.

9 Select Apply.
Set the GC injector parameters
If you are not using the autosampler, skip this section.

1 Select the ALS button, .

2 Select the Front Injector, Back Injector, or Dual tab, depending 
on your hardware configuration.

3 In the Injection area:

a Verify that the 10 µL Syringe Size matches your hardware 
configuration.

b In the Injection Volume field, enter 1.

4 In the Washes and Pumps area:

a For Solvent A Washes, enter 5 in the PostInj field.

b For Sample Washes, enter 3 in the PreInj field.

c For Sample Pumps, enter 5 in the PreInj field.

5 Select the Advanced button, . Additional options 
are displayed in the window.

6 In the Plunger Speed area, select Fast.

7 Select Apply.
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2 Create a Method for Qualitative Analysis
Set the GC detector

Figure 11 ALS parameters
1 Select the Detectors button, .

2 Select the Heater checkbox and enter 300 for the heater 
setpoint.

3 Select the H2 Flow checkbox and enter 30 mL/min for the H2 
Flow setpoint.

4 Select the Air Flow checkbox and enter 400 mL/min for the Air 
Flow setpoint.

5 Select the Makeup Flow checkbox and enter 25 mL/min for 
the Makeup Flow setpoint.

6 Select the Flame checkbox to ignite the flame. When igniting 
the flame, the detector will attempt ignition several times.

7 Select Apply.
Agilent GC ChemStation Familiarization Guide
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Set the GC signals parameters

Figure 12 Detector parameters
Agilent GC ChemStation Familiarization
1 Select the Signals button, .

2 From the Signal Source dropdown list, select Front (or Back) 
Signal (FID) for the signal source.

When using multiple detectors you may assign specific 
signals to both the Front Signals and the Back Signals. See 
the online help for configuration instructions.

3 For the Data Rate / Min peak Width select 20 Hz/.01 min from 
the dropdown menu.

4 In the Signal Source dropdown list, select None for the other 
signal sources.
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2 Create a Method for Qualitative Analysis
Figure 13 GC signals parameters
5 Select OK to download the selected parameters to the GC 
and close the Setup Method window. 
Agilent GC ChemStation Familiarization Guide



Create a Method for Qualitative Analysis 2
Save the method
Agilent GC ChemStation Familiarization
1 From the Method menu select Save Method As to display the 
Save Method As dialog.

2 Enter checkout.M in the Method File field.

3 Click OK to save the current ChemStation method as 
checkout.m method.  
 
If the Method Audit Trail is enabled you are prompted to 
enter an Audit Trail comment. Enter a comment and click 
OK to close the dialog.
General Information for Editing the GC Parameters

Open the GC edit parameters window

Figure 14 Saving the method
1 From the Instrument menu select Edit Agilent 7890 Parameters 
to display the Setup Method window. See Figure 8 on page 27.

2 When a parameter button at the top of the screen is 
selected, the button is highlighted in blue and the settings 
for that parameter are displayed in the right panel. The GC 
instrument status is shown in the left panel. 
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Add a column to ChemStation local inventory
36
1 Select the Configuration icon to display the columns 
configured for the instrument.
Figure 15 Columns configured for the instrument
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2 Click Inventory to display the Install Column 1 dialog box 
containing a list of columns in local inventory.
Figure 16 The local inventory of columns
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3 Click Add Column to Local Inventory to display the Add Column to 
Local Inventory dialog box.
Figure 17 The catalog of columns
4 Scroll down the list of columns to model number 19091J-433 
and enter the column serial number hp5ms433 as the New 
Inventory# or select the default. The column serial number is 
found on the column tag.

5 Click Add Selected Column to Inventory to display the Install 
Column 1 dialog box with the selected column now added to 
the local inventory list.
Figure 18 Local inventory with the added column
Columns added to local inventory can be quickly added and 
configured for the instrument. See “Select and configure a 
column”  on page 39.
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Select and configure a column
Agilent GC ChemStation Familiarization
This example selects a column previously added to local column 
inventory and configures it as column number 1. See “Add a 
column to ChemStation local inventory”  on page 36.

1 Select the Configuration icon and click on the Column 
description for column 1 to select it. The column number 
selected here will be replaced with the column we are 
adding.
Figure 19 Columns configured for the instrument
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2 Click Inventory to display the Install Column 1 dialog box 
containing a list of columns in local inventory.
Figure 20 The local inventory of columns
3 Select a column from the local inventory list and click Install 
Selected Column to display the Configuration panel for Setup 
Method with the selected column replacing the previously 
configured column 1 for the instrument.
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Figure 21 Columns configured for the instrument
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4 Under the Inlet heading dropdown, select the item the 
column inlet is attached to.

5 Under the Outlet heading dropdown, select the item the 
column outlet is attached to.

6 Under the Heated By heading dropdown, select the method 
for controlling the column temperature.
Change a column directly from the Setup Method Columns dialog
1 From the Setup Method dialog with the Columns icon selected 
(Figure 9 on page 29), click Change Column to display the Edit 
Properties of Installed GC Column dialog.

2 You can specify a column by setting the parameters in the 
dialog and clicking OK or optionally you can replace the 
column selected for the current method with one specified 
in inventory.

3 To select a column from inventory, click Replace with 
Inventory to display the Install Column 1 dialog (Figure 20 on 
page 40).
 Guide 41



42

2 Create a Method for Qualitative Analysis
4 Select a column from the local inventory list and click Install 
Selected Column to display the Setup Method for Columns dialog 
with the selected column replacing the previously 
configured column 1 for the instrument.
Upload parameters from the 7890A GC

Figure 22 Edit properties of installed GC column
From the GC Edit Parameter dialog, right mouse click in the right 
panel and select Upload Method from GC. 

Also, from the main menu you can select Instrument > Upload 
Method from Agilent 7890A.
Customize the status panel view
1 In the status panel, select the Setup Actuals button, the Status 
Items dialog box opens. 
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2 Mark the checkboxes of the items in the Status Item list that 
you want to have displayed in the status panel.

3 To move an item up or down in the displayed list, select the 
item and then the up or down arrow buttons until it is in the 
desired position.

4 Select Save to save the settings and return to the GC Edit 
Parameters window.
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Assigning Signals with Dual Simultaneous Injections
44
Dual Simultaneous Injections require a front and back inlet to 
make the simultaneous injections. They also require a Front and 
Back detector for analysis of these analytical streams. These 
analytical streams can be further spit to enter two or more 
detectors. A procedure is required for assigning each of these 
signals to the front or back signal location. 
Signal Assignments for Dual Simultaneous Injections
1 From the Setup Method dialog, click on the Signals icon.
2 For the first item in the table, select a Signal Source 
associated with the front inlet from the dropdown menu.

3 For the next item in the table, select a Signal Source 
associated with the back inlet from the dropdown menu.

4 For each detector Signal Source entered in the table, enter a 
Data Rate/Min Peak Width.

5 Select Zero for each signal you wish to zero at the start of the 
run. 

6 Save the data for each signal by selecting the Save checkbox.

7 If you disable the Save feature, data from the signal can be 
plotted on the online plot, but will not be stored for analysis.
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8 Click Show Signal Assignments for Dual Simultaneous Injections 
to display a Dual column and slider selector on the left side 
of the table.
9  Move the slider to display F in the Dual column of all Signal 
Sources associated with the front inlet. The other Signal 
Sources are associated with the back inlet. 

10 Click Apply to download these setting to the GC.

11 Save the method.
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Run a Single Sample

Prepare the Sample    48

Load the Method    48

Complete the Run Time Checklist    49

Run the Method    50

View the Current Logbook File    51

View the Log of the Run    52

In this chapter, a sample is prepared and run for data 
acquisition. 
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Prepare the Sample
48
1 Fill a sample vial with the contents of the 0.5 mL ampule, 
Agilent sample p/n 5188-5372, and cap the vial.

If you are not using an ALS skip the remaining steps.

2 Place the sample vial into position 1 of the GC sample tray.

3 For solvent wash mode A, B:

• Fill a solvent wash vial with iso-Octane and place it in 
injector turret location A.

• Place a waste vial in injector turret location W.
Load the Method
1 To start the GC ChemStation, from the Windows start icon, 
click All Programs, click Agilent ChemStation, then click the 
online ChemStation program for your instrument.
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2 Select the Load Method button,  to open the Load 
Method window. Navigate to and select checkout.M.
3 Select OK to load the method and close the dialog box.
Complete the Run Time Checklist
On the Run Time Checklist dialog, you will mark the check box for 
each section of a method that you want to be run.

1 In the Method and Run Control view in the Method menu click 
Run Time Checklist to display the Run time Checklist dialog.

2 In the Check Method Selections to Run area, for this example:

a Mark the Data Acquisition check box. 

b Mark the Standard Data Analysis check box.

c Clear the other check boxes.

3 You can optionally mark the Save Method with Data check box.

4 Select OK to set the sections of the method to run and close 
the dialog box.
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Run the Method
50
1 Open the RunControl menu and choose Sample Info. 

2 In the Operator Name field, enter your name.

3 In the Data File area:

a For the Path accept the default shown.

b Enter CHECKOUT as a subdirectory name.

c Select Manual and enter checkout.D in the Signal 1 field.

Figure 23 Start a single sample run
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4 In the Sample Parameters area:

a Select Front or Back to specify the location of the ALS.

b In the Sample Name field, enter a name for your sample 
(optional).

c In the Location field, enter the tray location where the vial 
is located. Here we entered 10 and the system changes 
our entry to Vial 10. Vial position numbers are labeled on 
the trays. If you are making a blank run do not locate a 
vial at the specified position. 
 
- The 7693 sample tray has 150 labeled vial positions 
- The 7683 sample tray has 100 labeled vial positions

d If not using a tray the vial locations are, 101 for front and 
201 for back.

e The Sample Amount field and the ISTD Amount fields are not 
required for Qualitative calculations.

f For the Dilution and Multiplier fields keep the default value 
of 1.

g In the Comment field, enter a comment (optional). 

5 Click Run Method to close the dialog box and start the run. 
The ready state indicator changes to Run. The data acquired 
during this run is used later starting in “Setup Data Analysis 
Options”  on page 54.
View the Current Logbook File
The Current Logbook File lets you review event messages from 
the instrument.

1 In the Method and Run Control view select the Show/Hide 

current online Logbook button  to display the Current 
Logbook File dialog for the instrument.
2 To print the log select View>Logbook>Print Logbook.

3 To save the log in another location select View>Logbook>Save 
As.
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View the Log of the Run
52
The system keeps a logbook named RUN.LOG that records all 
instrument error and status messages prior to and during data 
acquisition. This logbook is stored with each data file.

1 In the Method and Run Control view select View>Logbook>Open 
Logbook to display the Open Log Book dialog.
2 Use the right pane to browse to the data directory that 
contains the run log that you wish to view.

3 Select RUN.LOG from the left pane and click OK to display 
the Open Log Book File dialog for the selected data file.
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Qualitative Data Analysis

Setup Data Analysis Options    54

Edit Integration Events    57

Manually Integrate Peaks    61

Modify the Method to Print a Report    63

Qualitative data analysis identifies the compounds in your 
sample by:

• Integrating the peaks in your acquisition data. Integration is 
a tool for finding the peaks in a chromatogram and 
determining their size and retention time. 

• Identifying the compound by the peak’s retention time

• Allowing interactive manual integration of peaks

• Reporting the identity of the compound(s) found for each 
peak

This chapter reviews each of these processes. 
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Setup Data Analysis Options
54
1 From the Windows Start button select All Programs>Agilent 
ChemStation and click the name of your Offline Instrument. 

The ChemStation is displayed in offline mode. 

2 Click the Data Analysis button in the ChemStation Explorer 
window to view the Data Analysis window. 

The Integration tab is selected by default. 

3 Click the View Preferences icon to display the Preferences 
dialog.

When we load a data file we can set an option to 
automatically integrate the file after it is loaded.
4 Under the Signal/Review Options tab, in the Load Signal Options 
Area, select Integrate after load.

5 In the Data Review Options area, for the Method used for Single 
Run Data select Current Method. This is the master method.

6 Click OK to close the dialog. 
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7 Select Graphics>Signal Options, to display the Signal Options 
dialog to set the Autoscale feature.

8 In the Ranges area select Autoscale and click OK to close the 
dialog.

The algorithm for autoscale does not work by selecting 
peaks. It splits the data points into “buckets”, then looks at 
the max and min in each bucket, throws out the largest, and 
uses the second largest to base the scaling on. This is not 
necessarily the second largest peak (it depends on the size 
of the data point “buckets”).

9 Double click the ChemStation Explorer tree CHECKOUT 
subdirectory to load all single run data files into the 
Navigation Table.

Data files are organized into Single runs and Sequences.

10 Navigate to the CHECKOUT.D. data file in the Navigation Table. 
This is the acquisition data file created from our sample run.

11 Double-click the CHECKOUT.D. data file line in the table. The 
data file is loaded and its chromatogram is displayed 
according to its method settings. 

The data file is automatically integrated and the 
chromatogram is automatically scaled to fit the in the 
window. 

If the chromatogram displays only a single large peak, you 
may not have set the Autoscale feature, as described in Step 7
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Edit Integration Events

Display integration events
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When the data analysis part of your method is run, the 
chromatogram is integrated. Most chromatograms can be 
successfully integrated using the ChemStation default auto 
integration parameters. However, you may edit these auto 
integration event values and add additional integration events 
for your specific method. 

1 Click the Auto Integrate icon  to calculate suitable initial 
integration event parameters for the loaded signal.

2 Select the Edit/Set Integration Events Table icon . 

The Integration Event Table displays next to the chromatogram. 
Here, the lower integration events table displays the initial 
time values we created using Auto Integrate.
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Set area reject
58
To demonstrate how Integration Events are used to filter peaks, 
we will remove the peak located at time 4.554 using the Area 
Reject event and then remove the peaks located at times 0.637 
and 1.387 by turning the integrator off before it reaches these 
peaks and then turning the integrator back on after these peaks 
are processed. 

To remove a peak using the Area Reject event:

1 Select FID1 A Specific from the Specific Events for Signal drop 
down menu. In this example this is the front detector signal 
shown in the chromatogram. These events apply to this 
signal only.

2 Click on the Area Reject icon , mouse over the 
chromatogram, and observe the vertical line that moves with 
the cursor.

3 Move the vertical line to the 2.3 minute time and click the 
left-mouse button. The Area Reject event is added to the 
Integration Events table at this time and given a Value of 0.

4 Set the Area Reject Value to 3.0 in the Integration Events table 

and click  to complete this edit. This peak at 4.554 
minutes is filtered out and removed from the table.
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Set integration off and on

Filtered peak
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To remove peaks using the Integration Off/On event:

1 Click on the Integration icon , mouse over the 
chromatogram, and observe the vertical line that moves with 
the cursor.

2 Move the vertical line to the 0.2 minute mark and click the 
left-mouse button. The Integration OFF event is added to the 
Integration Events table at this time. 

3 Move the vertical line to the 2.0 minute mark and click the 
left-mouse button. The Integration ON event is added to the 
Integration Events table at this time. 

4 Click on  to complete this edit. 
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Filtered Peaks
60
The peaks located between times 0.637 and 1.387 are now filtered 
out and removed from the table.

Note the times displayed vertically at < 0.200, < 2.000, and  
< 2.300 in the graph above. These times are also shown in the 
lower left Integration Events Table. These are the times we 
entered for the integrator to stop and start and the time that 
area reject starts. 

The Peak table in the lower right that originally contained 7 
peaks now contains only 4 peaks.
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Manually Integrate Peaks
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Manual peak integration allows interactive modification of peak 
integration for a data file. A set of graphic tools allows 
modification of the chromatogram directly. These changes can 
be saved with the data file (available since ChemStation 
revision B.04.01) or saved with the method. This section 
examines manual integration saved with data files.

1 Load a signal data file by selecting File > Load Signal from the 
menu to display the Load Signal dialog.

You can also load the file from the navigation table, which is 
read only.
2 In the right pane select the CHECKOUT folder where the data 
file is located then, from the left panel, select the 
CHECKOUT.D data file to be integrated and click OK.

3 Click the Integrate icon to integrate the signal with the 
specified method’s integration events. 

4 Select the Zoom In icon then, click and drag the left 
mouse button to zoom in on the peak of interest at 2.92 
minutes in the chromatogram.
5 Select the Manual integration: Remove integrated Peak(s) from the 

Integration Results icon , then click the peak at 2.92 
minutes to delete its peak. The peak table located below the 
chromatogram no longer contains this peak.
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6 Select the Manual integration: Draw Peak baseline(s) and 

integrate icon , then click and drag the right mouse 
button to draw an integration baseline on the peak. When 
you release the button, the peak will be integrated and 
added to the peak table located below the chromatogram.

7 Other tools available include:

• The Undo icon  to undo the last manual event edit

• The Zoom out icon 

• The Draw Negative Peak Baseline icon  

• The Tangent Skim One Peak icon 

• The Split Manually Integrated Peaks icon 

8 Click the Save icon to save the current manual 
integration events to this data file. This is the recommended 
method for saving a manual integration.

When a manual integration events file is saved with the data 
file, the Manual Events column of the Navigation Table is 

marked with the  symbol.

9 The Delete icon  is used to delete all manual events 
from the data file. The manual integration file remains with 
the data file until this delete action is saved. Click the Save 

icon to permanently delete the current manual events 
file from this data file.
Agilent GC ChemStation Familiarization Guide



Qualitative Data Analysis 4
Modify the Method to Print a Report
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1 Click the Specify Report Calculation and Print Style icon  to 
display the Specify Report dialog. 
 
You can also select this dialog from the menu by selecting 
Report > Specify Report.
2 To create an area percent report, in the Quantitative Results 
area, select Percent for Calculate, Area for Based On and Signal 
for Sort By.

3 For destination select Printer and Screen.

4 Click the Identify Peaks, calculate and preview results icon  
to view the Report. To Print the Report, from the main menu 
select Print > Report.

5 Click the Identify Peaks, calculate Results and Print Reports icon 

 to send a copy of the report to the printer.

6 Click the Save Method icon  to save the report 
specification to the method or select Method > Save Method 
As to create a method with a new name.
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Create and Run a Sequence

Sequence Data File Storage    66

Prepare the Samples    68

Set the Sequence Parameters    69

Create and Run a Sequence    70

Partial Sequence    73

Sequence Reprocessing    76

A sequence is a list of samples to be analyzed and a designated 
method to be used for each analysis. Once defined, the sequence 
may run unattended, automatically processing the samples 
defined in the sequence.

When an ALS is installed, the entire analysis, from injection of 
the sample through reporting of results, can be automated to 
save you time.

The data files generated when running the sequence in this 
chapter will be used to create a calibration curve in the next 
chapter.
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Sequence Data File Storage
66
Before creating a sequence, check the unique folder creation 
setting is on. See “Set the sequence preference” below.

When this Data Storage preference (Unique Folder Creation ON) 
is selected, sequences are reprocessed from the Data Analysis 
view. It will not be possible to reprocess any sequence using this 
data storage selection from Method & Run Control\Sequence\
Sequence Parameters.

All data files, copy of the sequence table template (Sequence.S), 
all methods used in the sequence table, the batch (.B) file, and 
the sequence log are stored together in one folder under the 
Data Directory (C:\Chem32\1\Data). Generally, this folder is 
called the sequence folder or sequence container. Each data file 
also contains two methods, ACQ.M and DA.M. 

For more detailed information on this subject please see the 
Agilent ChemStation Getting Started with New ChemStation 
Workflow manual (G2170-90044).
Set the sequence preference

Table 4 Method type, location, and use with Unique Folder Creation ON preference set

Method Location of Method Acquisition Reprocess Data 
Review

Master 

Method

C:\Chem32\1\Methods Yes No Yes

Sequence 

Method

C:\Chem32\1\Data\ Subdirectory\Sequence_container\ No Yes Yes

DA.M C:\Chem32\1\Data\ Subdirectory\Sequence_container\Data.d No No Yes

ACQ.M C:\Chem32\1\Data\ Subdirectory\Sequence_container\Data.d No No No
1 Start a ChemStation online session.

2 From the main menu select View > Preferences to display the 
Preferences dialog. 
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Figure 24 Setting the sequence preference
Agilent GC ChemStation Familiarization
3 Under the Data Storage area select Unique Folder Creation ON. 
This option specifies that each time a sequence is run, the 
system creates a unique directory where it stores all files 
related to the completed sequence run including its 
methods, logs, batch files, and data files.

4 In the Name Pattern area, optionally change the default name 
pattern for the sequence container (storage directory). This 
default name pattern is made using the sequence name with 
a time stamp appended to assure its uniqueness. See the 
online help for other naming options.

5 Click OK to close the dialog.
 Guide 67



5 Create and Run a Sequence
Prepare the Samples
68
1 Fill a sample vial with the contents of the 0.5 mL ampule, 
Agilent sample p/n 5188-5372 and cap the vial. Mark this 
vial as the 23.6 mg/µL calibration standard.

2 Fill a sample vial with the contents of the 0.5 mL ampule, 
Agilent sample p/n 5188-5372. Add an equal amount 
iso-Octane to the vial for a 1:2 serial dilution and mix the 
vial contents.

3 Remove 0.5 mL from this vial, place it in a new vial, and cap 
the original vial. Mark this capped vial as the 11.8 mg/µL 
calibration standard.

4 Take the uncapped vial from the previous step and add 0.5 
mL of iso-Octane to the vial for a 1:2 serial dilution and cap 
the vial. Mark this vial as the 5.9 mg/µL calibration 
standard.

5 Make an unknown concentration sample in a vial by diluting 
a 23.6ug/mL solution. Cap and mark this vial unknown 
sample.

6 If you are not using an ALS skip the remaining steps.

7 If you are using an ALS:

a Place the sample calibration vials into positions 20 
through 22 of the GC sample tray. Place the lowest 
concentration level in position 20, and the other two in 
order of increasing concentration. 

b Place the unknown sample vial in position 23.

c Fill a solvent wash vial with iso-Octane and place it in 
injector turret location A for solvent wash mode A, B.

d Place a waste vial in turret location W specified for 
solvent wash mode A, B.
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Set the Sequence Parameters
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1 With the ChemStation running in online mode, click the 
Method and Run Control button to display the Method and Run 
Control view with the Instrument Control tab selected.

2 Load the CHECKOUT.M method.

3 From the Sequence menu, select New Sequence Template to 
clear any entries from the current sequence table.

4 From the Sequence menu, select Sequence Parameters to 
display the Sequence Parameters dialog.
5 With the Sequence Parameters tab selected, select a Data File 
Path from the drop down. If the required path is not shown, 
access the Preferences dialog to add it.

6 In the Part of method to run area, select According to Runtime 
Checklist.

7 Enter your name in the Operator Name field.

8 Click OK to close the dialog.
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Create and Run a Sequence
70
1 From the Sequence menu, select Sequence Table to display an 
empty Sequence Table dialog.
2 Click the Append Line button twice to add two lines to the 
table.

3 Click the Insert/Filldown Wizard button to display the Filldown 
Wizard dialog.

4 In the Action area select Fill down and In the List of detected 
ranges, select both lines.

5 In the Location assignments area, set the Starting location to 20 
and the Increment by value to 1. This specifies that the first 
vial is located in position 20 and the other vials are in 
locations 21 and 22 in the ALS tray.

6 In the Fields area, click the Clear All Fields button and do not 
select Omit other sample types.

7 Select the CHECKOUT method from the Method name drop 
down list and select Calibration from the Sample type drop 
down list.

8 In the Sample name field enter CAL\C1\. The \C1\ parameter 
creates samples names CAL1, CAL2, and CAL3. For other 
applicable configurations click the Help button.
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9 Click OK to close the dialog and fill in the required columns 
in the Sequence Table.

10 In the Sequence Table Cal Level column, for samples 2 and 3, 
change the entries to 2 and 3.

11 Click the Append Line button to append a line to the table.

12 Enter a Vial number of 23 and a Sample Name of unknown01.
 Guide 71



72

5 Create and Run a Sequence
13 Click OK to close the dialog.

14 From the main menu select Sequence > Save Sequence As to 
open the Save Sequence as dialog and enter CHECKOUT as the 
sequence name. For the location use the 
chem32/instrumentNumber/sequence directory. This is the 
directory where the sequence templates are stored.

This sequence becomes the current default sequence.
15 From the main menu select Sequence > Run Sequence to run 
the CHECKOUT.s sequence or click the Start Sequence button 

on the sampling diagram.
The sequence acquires data files for all three calibration 
samples and our unknown sample.

In the next chapter we will create a calibration table using data 
acquired with this sequence. 
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Partial Sequence
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Partial Sequence can be used to acquire data into a new 
sequence container or to add runs to an existing sequence 
container.   It can also be used to preview the run order of the 
sequence or to select specific runs for data acquisition or data 
reprocessing. 

1 From the Method and Run Control display, select the Sequence 
menu in the tool bar.

2 Select Partial Sequence. 

A list of sequence containers are shown with the last run 
sequence listed first.
Acquire data into an existing container
1 To acquire data into an existing sequence container, first 
select the sequence container from the list and click Ok.

While the selected sequences are being parsed, a timeline 
shows the progress. You can click to abort the process.
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All runs are displayed in order. If the runs exceed the 
viewable area, use the vertical scroll to view more of the 
listings. 

2 Select the run/s desired for data acquisition/ analysis/ 
reprocessing.
In the sequence shown in the dialog box, only one sample was 
run. The completed run is shown by a vial icon in the Exists 
column. 

It is possible to select all samples, only the remaining samples, 
or just the front or back samples. 

3 Select All if you want to re-run all 3 samples.  
 
OR 
 
Select the Remaining button if you want to run the other 
samples and run 2 and 3 will be highlighted. 

4 Select Run Sequence. The sequence container will now 
include 3 completed runs.
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Acquire data into new sequence container
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1 To place this data into a new container, select All and each 
line is highlighted.
2 Select the Run Sequence button. A new sequence container is 
created with the 3 data files.

The new container is automatically named.
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Sequence Reprocessing
76
Reprocessing is accessed from the Data Analysis view. It uses 
copies of method and sequence files in the sequence container; 
however not all parameters can be changed. Only the relevant 
Sequence Parameter fields for reprocessing are accessible. 

During reprocessing, all changes in the DA.M are overwritten. 
All new methods are written into the Sample Container. 
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Create a Calibration Table    78

Reprocess the Sequence    83

This chapter describes how to add compounds to the calibration 
table stored in your method. After a compound is identified, 
quantitative data analysis determines the amount of the 
compound in your sample by comparing the response from a 
known measured amount of the compound, stored in the 
calibration table, to the response from an unknown amount of 
compound.
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Create a Calibration Table
78
1 Start an offline session of the ChemStation and select Data 
Analysis view from the ChemStation Explorer.
2 In ChemStation Explorer, double click the sequence you just 
acquired to load its 4 data files into the navigation table. The 
unique sequence name, which includes a time stamp, is 
displayed to the right of a three blue sample vial icon. This 
sequence name is displayed in bold when its sample data is 
displayed in the navigation table.

3 Select Use sequence method from the drop down menu.

4 In the navigation table, double click the 1st calibrant data 
row to load and display its chromatogram.

The navigation table is read only.
NOTE
5 From the Calibration menu select New Calibration Table to 
display the Calibrate dialog.
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6 With Automatic Setup Level selected for level 1, set the Default 
Amount to 5.9 ng/µL and click OK to display the Calibration 
Table below the chromatogram of the 1st calibrant with 4 
integrated peaks entered. 

This view is in Data Analysis with the Calibration tab selected. 
The units label shown in the Amt column can be changed in 
the Calibration Settings dialog accessed by selecting Calibration 
> Calibration Settings from the main menu.
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7 To quickly locate a Calibration Table entry for a peak in the 

chromatogram, use the select peak tool  and click on the 
chromatogram peak to highlight its row in the Calibration 
Table.

8 Click the delete peak tool  and the cursor changes to a 
peak symbol with an “X” over it. Click this cursor on the 
peaks in the chromatogram at 2.9 minutes and 3.5 minutes to 
delete them from the Calibration Table.

The Calibration Table now only contains the peaks at 4.1 and 
4.7 minutes.

9 For the peak at 4.1 minutes enter n-Penta-decane as the 
Compound name.
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10 For the peak at 4.7 minutes enter n-Hexadecane as the 
Compound name.
Add levels to a calibration table
1 In the navigation table, double click the 2nd calibrant data 
row to load and display its chromatogram.

2 From the Calibration menu select Add Level to display the 
Calibrate dialog.

3 With Level set to 2, set the Default Amount to 11.8 ng/µL and 
click OK to display a level 2 added to the Calibration Table for 
both compounds. 

4 In the navigation table, double click the 3rd calibrant data 
row to load and display its chromatogram.

5 From the Calibration menu select Add Level to display the 
Calibrate dialog.
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6 With Level set to 3, set the Default Amount to 23.6 ng/µL and 
click OK to display a level 3 added to the Calibration Table for 
both compounds. 
7 Save this calibration table to the sequence method by 
selecting Method > Update Sequence Method from the main 
menu.
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1 Run sequence reprocessing by clicking the  icon.

The report is printed and now contains the concentration of 
the unknown sample. If you are satisfied this sequence 
method, you can update this method to the master method 
for next analysis.

2 To update this method to the master method, select Method 
> Update Master Method from the main menu.
Sequence summary report
The tools shown in the navigation table will allow you to 
make changes to this file without going to the Method and Run 
Control view.

1 With the sequence loaded, open the Sequence Parameters 
dialog by clicking on the icon shown below.

2 Select the Sequence Output tab and deselect the Print individual 
reports for each run checkbox.
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3 Select the Setup button to display the Sequence Summary 
Parameters dialog with the Reports tab selected.

4 Items 5 and 9 are selected. Select item 9. Summary, with 
Compound Summary selected from the dropdown. Click OK to 
close the dialog.

5 To reprocess the sequence, select the Start sequence 
reprocessing tool displayed below.

6 The sequence will reprocess. You will notice that the status 
bar turns blue to indicate the sequence is reprocessing. The 
method and a Compound Summary should print at the end 
of the sequence.

7 Examine the method. You should see the record of your 
action in the Change History. 

8 Save the sequence to accept changes if desired.
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Easy Sequence

Create an Easy Sequence Template    86

Create an Easy Sequence from a Sequence Template    93

View the Sequence Queue    96

Edit a Sequence in the Sequence Queue    101

The ChemStation Easy Sequence feature allows you to create a 
template (called an Easy Sequence Template) that contains 
information you routinely use in sequences. 

This template (the .est file) includes sample attributes that do 
not typically change from sequence-to-sequence, such as the 
number of samples in a sequence, sample naming conventions, 
data storage locations, calibrants, response factors, and so on.

After this template is created, it is used over and over again, as 
the starting point for creating new sequence files. The sequence 
files created from an Easy Sequence Template are called Easy 
Sequence files (.es files).

This chapter describes: 

• How to create an Easy Sequence Template (.est file)

• How to create an Easy Sequence from that template (.es file)

• How to add the Easy Sequence to the sequence queue. 
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Create an Easy Sequence Template
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When you create an Easy Sequence Template (.est file) you will 
enter sample and calibration attributes that will not typically 
change from one sequence to another. Both processes, entering 
sample information and entering calibration information, are 
described in this Chapter.
Sample information
To enter sample details for the template: 

1 Select the Easy Sequence Setup tab from the Method and Run 
Control window.

2 If not already highlighted, select the Samples tab. This screen 
shows the sample attributes you may specify as the starting 
point for your sequences. The information you enter here 
will be pre-filled when this template is used as the starting 
point for an Easy Sequence.
Agilent GC ChemStation Familiarization Guide



Easy Sequence 7

Agilent GC ChemStation Familiarization
To begin, identify the method you would like used for your 
sequences. 
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3 In the Method Information area, click the ellipsis in the Method 
field, then browse to and select the method you want. For 
this example, we are using MYMETHOD.M. 

4 Enter an Estimated Cycle Time for each run. This is for 
information purposes only. It is used by the ChemStation to 
provide an estimated completion time for queued sequences. 
For this example, use two minutes.
Estimated cycle time
Estimated cycle time is the GC cycle time, which is oven + Data 
Analysis + cool down. GC ready to GC ready.

Estimated cycle time only shows when the sequence is running 
in the queue and is not required, just a user estimate. Nothing 
depends on its accuracy.
Calibration information
Once you have saved the sample information for the Easy 
Sequence Template, as described in the previous section, you 
may add calibration details. 

1 Before moving to the Calibration tab, be sure to save your 
changes to the Samples section. If you do not, those details 
will be lost when you click the Calibration tab.  
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After saving the Samples section, click the Calibration tab. 

2 For this example, select Simple Calibration, from the 
Calibration Mode drop-down menu.
 Guide 89



7 Easy Sequence
90
3 For each calibrant you want included in the sequence 
template you will:

a Drag the Calibrant icon from the Sample Type area to the 
Sequence Start area, in the left column.

b Enter the calibrant details (Vial Location, Injections/Vial, 
Calibrant Level, Response Factor, and Retention Type), in the 
center column.

c Click Accept Changes to update the template. Notice the 
updated details in the right column under Easy Sequence 
Overview.
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For this example enter 3 calibrants: 

Calibrant Name: CAL1 CAL2 CAL3

Vial Location: 20 21 22

Injections/Vial: 1 1 1

Calibration Level: 1 2 3

Update Response Factor: Average Average Average

Update Retention Time: Average Average Average
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4 Next, for this example, add a Blank to end the sequence. 
Similar to how you entered calibrants:

a Drag the icon for a Blank sample from the Sample Type area 
to the Sequence End area.

b In the center column, specify a Blank Name. 

c Click the ellipsis and select a method to be used to run 
the sample, and click OK.

d To use a solvent blank, select the Blank with injection, enter 
a Vial Location, and specify the Injection Volume.

e Click Accept Changes to update the template.

5 Review the Easy Sequence Overview panel (in the right 
column) to verify the calibration information is as you 

expect, and click the Save icon to save the changes to 
the template.

That completes the process of creating a sequence template. 

The next section describes how you may now use this template 
to easily create a sequence. 
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Now that you have created an Easy Sequence Template  
(.est file), you can use it to create an Easy Sequence (.es file).

To create an Easy Sequence from an Easy Sequence Template:

1 From the Method and Run Control panel, access the Easy 
Sequence tab.

2 Click the Open Easy Sequence Setup icon to load the 
template.

3 Browse to the template you wish to use and click OK to load 
the template. 
4 This is your starting point for your new sequence. Notice the 
default information is the information you entered in your 
Easy Sequence Template (the .est file).  
 
Notice the greyed out fields: Method, Estimated Cycle Time, 
Sample Name, Data Location, Data File Name. These are the 
fields that were set to Read Only when this template was 
created.
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5 Modify these default values, to create the sequence you 
need.  
 
For this example, make the Sample Information match the 
example shown above.

a Starting Vial Location: 30 

b Number of Samples: 10 

c Injection Volume: Use Method:

6 Click the Fill Samples button to populate the samples list. 
This will add the number of samples defined in the Number of 
Samples field the Samples List. 
7 Because we are running calibration samples in this example, 
click the Calibration List tab, to view the calibration samples. 
That completes the entries needed to create the sequence.
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8 To review a report for this sequence, click the Preview/Print 
Sequence button. 

9 Use the scroll bar to see the bottom portion of the report.

10 Click Print Sequence... to print a copy if you desire. 

11 Click the Close button to return to the Sample table. 

12 To save and run this sequence, click the Save and Add to Queue 
button. 

13 Enter a filename for this sequence, and click Save.

That concludes the process. The Easy Sequence is now saved 
and has been added to the Sequence Queue.  
 
Review the next section of this document for details on the 
Sequence Queue.
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When you save an Easy Sequence, as described in the preceding 
section, it is automatically saved to the Sequence Queue.

1 To view the active sequence queue and the queue history, 
click the Sequence Queue tab.
2 Look at the top of the queue to see sequences that are 
currently running and scheduled to run (pending). 

3 Look at the bottom of the screen (the History Queue 
section), to see the completed sequences. 

You may click the History icon , in the upper right 
corner of the screen, to toggle the History Queue on or off. 

4 Click the plus or minus sign next to the sequence name, to 
expand or collapse details for each sequence in either the 
current queue or the history queue. 
Agilent GC ChemStation Familiarization Guide



Easy Sequence 7

Agilent GC ChemStation Familiarization
5 To move a sequence to a different time slot, highlight the 

sequence and click the Move icon . 

The above graphic shows MySequence3 was moved ahead of 
MySequence.
Sequence queue considerations
The Easy Sequence acquisition begins as soon as the data 
system is ready, unless Paused from the Queue.

• Once an Easy Sequence is started, it cannot be changed from 
the Easy Sequence UI. It becomes a ChemStation sequence 
(.s) and can be opened and edited in the Sequence Table.

• If any changes are made to the running sequence in the 
Sequence Table and the sequence is not saved, the queue will 
be paused at the sequence conclusion. Saving the sequence 
will be necessary before the next sequence in the queue will 
begin.

• Only pending Easy Sequences in the queue can be edited.

• If an error occurs at any point in the execution of a sequence, 
the ChemStation sequence will abort and the Easy Sequence 
will be sent to the History Queue with an error status. You 
must reload the Easy Sequence (.es), modify as needed, and 
resend to the queue. 
Priority sample
• Pause the Queue if using Easy Sequence.

• Pause Sequence from RunControl menu.
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• Use RunMethod (F5) to specify sample, method, and 
injection information.

• After running all priority samples, Resume Sequence.

6 Next, fill in the global Sample Information.  
Include the:

• Starting Vial Location of the first sample vial (30 for this 
example.)

• Number of Samples (10 for this example.)

• Injection Volume (For this example, leave this set to Use 
Method.)

7 In the Sample Name field, enter the name you wish to use for 
the samples in your sequences, and the way you want each 
sample name to increment. For this example, enter 
MySample_ for the Sample Name, then click the right arrow at 
the right end of the field to display the sample naming 
options, and select Counter.  
 
Counter adds a sequential number to the end of the sample 
name for each sample created.   In this example, 
MySample_1 will be the first, MySample_2 for the next, and 
so on.
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8 In the Data Information area, enter the desired Data Location 
for storing the data files, the Data File Name, and naming 
convention. For this example, use the default location, 
MyDataFile_ for the Data File Name, and add a Counter on the 
end of this name, similar to the Sample Name. 

9 For this example, check the Reset Data File Name counter. 
This will reset the Data File Name counter to 1 every time 
the sequence is run. 

10 Select the Hide or Read Only check boxes to specify the 
parameters that you would like to be available when this 
template is used to create a sequence.  
 
For this example, set the Sample Name, Data Location, and 
Data File Name to Read Only, and leave all other fields 
unchecked. Later, when this template is used to create a 
sequence, parameters defined as:

• Show (where nothing is checked) will be editable 

• Read Only will be shown, but will not be editable 
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Notice, Method Information parameters are always Read Only.

11 Use the Comments field to specify any additional sequence 
information or external links that you would like to pass on 
to anyone using this template to create a sequence. To enter 
a comment, click inside the comment box and type the 
appropriate information.

12 When all the information is filled in, click the Save Easy 

Sequence Setup As icon to display the Save Easy Sequence 
Setup As dialog, then enter a name for this template, MySetup 
for this example, and click Save to save the template. 
13 Notice this new template name, MySetup.est, is now 
displayed in the Easy Sequence Setup title bar. Now you may 
enter the calibration details, as described in the next 
section, to complete the template.
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1 Select the sequence you want to edit in the active queue. 
(Only Easy Sequences, those created with an Easy Sequence 
Template, can be opened with the Easy Sequence editor.)
2 Click the Edit Sequence icon, to open the editor. If the 
sequence you selected was scheduled to run next in the 
sequence queue, the sequence queue automatically pauses. 

3 Edit the information as necessary, (change the vial position 
for example), then click the Fill Sample button to update the 
sequence table. 

4 Click OK to save the changes and return to the sequence 
table.

5 Click the Resume Queue icon to resume the sequence.

Note that this changes the instance of the sequence in the 
sequence queue only. The original easy sequence (the .es file) 
and the easy sequence template (the .est file) do not change. 
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Create a GC Maintenance Method    104

Use the Maintenance Method    105

Shut Down the GC    106

This chapter describes how to create and store a method to use 
for instrument shutdown and maintenance tasks. Using this 
type of method helps prevent damage to the instrument 
electronics and columns, and avoid injuries such as burns or 
shocks.
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1 Select View > Method and Run Control.

2 Click the Instrument menu then click Edit Agilent 7890A 
Parameters to edit the currently loaded method. The Edit 
Method dialog box opens.

3 Select the Oven button, . The oven parameters are 
displayed.

4 In the Value field, enter 35°C. 

5 Mark the Oven Temp On checkbox.
6 Select the Inlets button, . The inlet parameters are 
displayed.

7 Select the front or back tab, depending on your hardware 
configuration.

8 Mark the Heater check box, and enter 35°C in the 
corresponding field.

9 Mark the Pressure check box. Column flow must be 
maintained to prevent damage to the column when hot.

10 Select the Detectors button, . The detector 
parameters are displayed.

11 Select the front or back tab, depending on your hardware 
configuration.

12 Mark the Heater check box, and enter 35°C in the 
corresponding field.

13 Mark the makeup gas on, and clear other gas and flame 
check box.
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14 Select the AUX button, .

15 Clear the On check box for any Aux x Heater and select OK.

16 Select Method>Save Method As. The Save Method As dialog box 
opens.

17 In the Method File field, enter maintenance.

18 Select OK.
Use the Maintenance Method
To use the maintenance method, load the method, access the 
Setup Method window, and right mouse click in the right panel. 
Select Download Method to GC from the context menu. A 
confirmation message is displayed.

Select OK to close the message and return to the Setup Method 
window. 

When the GC enters the Ready state, perform the maintenance.
WARNING Hot surfaces on the GC can possibility cause a skin burn injury. 
Before maintenance, make sure the oven, inlets, detectors and 
heated parts are cooled down, or wear heat-resistant gloves.
At the next power on, the GC and ChemStation will start up 
with its heated components maintained at a safe temperature. 
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Shut Down the GC
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1 In Method and Run Control, view, load the GC maintenance 
method.

2 Access the Setup Method window.

3 Right mouse click in the right panel and select Download 
Method to GC from the context menu. A confirmation 
message is displayed.

4 Select OK to close the message and return to the Setup 
Method window. 

5 Close the Setup Method window.

6 When the GC enters the Ready state, exit the ChemStation.

7 Turn off the power to the GC.

8 Turn off the carrier gas and gases to the detectors.

9 Power off the PC and all peripheral equipment.
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